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SharePoint deployments are continually growing, with new sites being created daily, distributing information all across the 

SharePoint farm. How can SharePoint site owners effectively share the wealth of knowledge contained in lists and libraries across 

sites or even site collections while still preserving the presentation views that were so painstakingly constructed?  

Cross-Site Display Web Part does just that. Simply add Cross-Site Display Web Part to a Web Part Page in any site and enter the list 

URL of the list or library to be displayed—from any site in any site collection. Using the concept of "what you see is what you 

get" (WYSIWYG), Cross-Site Display Web Part displays the SharePoint list or library just as if you were viewing it in a SharePoint List 

View. Support for standard list views like Calendar View and Gantt View, as well as support for the specialized views for Discussion 

Boards and Picture Libraries, means list and library information is presented in the format it was intended to be viewed.  

Need to display multiple lists and libraries from different sites or site collections? No problem! Just add a Cross-Site Display Web Part 

for each list or library you want to display. Each Web Part instance is configured individually so you can easily customize your page 

to create a cohesive presentation from distributed SharePoint information. 

The Cross-Site Display Web Part includes the following features: 
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Overview

Features

Feature Description 

View Lists Across Sites and Site 

Collections 

Remove the barrier that limits viewing of lists and libraries to the local site and instead view 

them across sites and even site collections.  

Comprehensive List and Library 

Support 

All WSS v3.0 and SharePoint Foundation 2010 list and library types are supported. 

Support for Default List and 

Library Views 

View all list and libraries in Standard View, Calendar View or Gantt View. 

Support for Special List and 

Library Views 

Special views for Discussion Boards, Picture Libraries and Survey Lists are also supported: 

� Discussion Board: Subject View, Flat View, Threaded View 

� Picture Library: Detailed View, Filmstrip View, Thumbnail View 

� Survey List: Overview, All Responses, Graphical Summary 

Change Views Quickly and Easily Using the SharePoint View drop-down menu, quickly switch between any supported list or 

library view, including personal views. 

Full Toolbar Support List and library display includes support for the full SharePoint toolbar menus: 

� New 

� Upload (Document Libraries) 

� Actions 

� Settings 

� View 

Item Context Menu Support Manage individual list items using the item context menu. 



For a complete list of new features, known issues, and product limitations for each release of Cross-Site Display Web Part, view the 

Release Notes. 

To configure the Cross-Site Display Web Part, select a list or library to display in the Web Part settings. The Cross-Site Display Web 

Part does the rest, displaying the default list or library view. Interact with list and library items, change views, and manage list 

settings just as you would from the standard SharePoint List View. 

 

The following lists, libraries, and views can be displayed in the Cross-Site Display Web Part: 

� Overview  

� Supported Lists and Libraries  

� System Requirements  

� Installation  

� Configuration  

� Using the Cross-Site Display Web Part  

� Licensing and Activation  

This section describes how to install, upgrade, uninstall, or activate the feature for the Cross-Site Display Web Part.  

How Does it Work?

Supported Lists and Libraries

Libraries 

Document Library 

Form Library 

Picture Library 

Wiki Page Library 

Lists 

Announcements 

Calendar 

Contacts 

Custom Lists 

Discussion Board 

Issue Tracking 

Links 

Project Tasks 

Survey 

Views—All Lists and Libraries 

Standard View 

Calendar View 

Gantt View 

Survey List Views 

Overview 

All Responses 

Graphical Summary 

Discussion Board Views 

Subject View 

Flat View 

Threaded View 

Picture Library Views 

Detailed View 

Filmstrip View 

Thumbnail View 

Cross-Site Display Web Part for SharePoint 2007 
Release 1.0 (HW63)

System Requirements

Operating System Microsoft Windows Server 2003 and 2008 

Server SharePoint Release 3: 

- Microsoft Windows SharePoint Services 3.0 or Microsoft Office SharePoint Server 2007 With 

Service Pack 2 

- Microsoft .NET Framework 2.0 or 3.0 

Browser Microsoft Internet Explorer 7 or higher 

Cross-Site Display Web Part Installation



� About the Setup Program  

� Installing the Prerequisites  

� Installing the Cross-Site Display Web Part  

� Manually Activating the Product Features  

� Locating the Error Log Files  

� Uninstalling the Cross-Site Display Web Part  

� Manually Installing or Uninstalling the Cross-Site Display Web Part  

Before installing the product, read the Installing the Product section of the Online Documentation and review KB.12464: Best 

Practices for Installing Bamboo Products. 

To access the Setup program: 

1. Download the self-extracting product EXE from the storefront and save it to a local folder on the SharePoint server.  

2. Double-click the product EXE file to extract the contents of the product download.  

3. The Setup program will automatically start. To start the Setup program manually, double-click the Setup.bat file in the 

root of the folder where the product files were extracted.  

The Setup program may look different for different product versions. See examples below of the two Setup programs that are 

currently in use. Both versions of the Setup program work the same way. 

  

Note: The minimum screen resolution to view the Setup program is 1024x768. 

The Setup program contains links to each product component under the Components header on the left. Click on any of these links 

to view a description of the component on the right. The component description contains important information about where to 

install the component and the required permissions for the installation account. Read this information carefully before proceeding.  

Each product may have several components, which fall into the following categories: 

� Prerequisites: Some products include prequisite components that must be installed before the Bamboo product core 

components. Not all products will have prerequisites. Examples of prerequisites include the Shared Assemblies Library, Microsoft 

AJAX Extensions, and Bamboo AJAX Config.  

� Core Components: The product will include one or more core components that are required for the Bamboo product to work.  

� Optional Items: Optional items provide additional features or functionality but are not required to use the Bamboo product. 

Not all products will have optional items. Examples of optional items include the MashPoint Runtime Components and sample 

ASP.NET applications.  

� Licensing: All products will include the Bamboo Web License Manager or Bamboo License Manager. Licensing is required to 

activate a product license. It is not required during 30-day product trials.  

� Help: The Setup program also contains links to the Online Documentation and the Installation and Licensing Quick Start Guide. 

Links to other product-related resources, like the Bamboo Knowledge Base, may also be included. 

After reviewing the installation location and required installation permissions for a component, click the Install button at the bottom 

of the Setup screen to install it. If the product includes multiple components, click the Install button for each component. 

About the Setup Program



Click the Home icon  to return to the Setup main page. 

  

About the extracted product files: 

The extracted product files include the file Setup.bat, which launches the Setup program, and may also include the following 

folders:  

� \[Product].wsp: Contains the solution deployment file for this product. There may be more than one product WSP 

folder, depending on the product.  

� \docs: Contains the Installation and Licensing Quick Start Guide.  

� \msi : Contains installation executables for this product.  

� \res: Contains files required by the Setup program.  

� There may be other folders, depending on the requirements for the product.  

Some products may have components listed in the Prerequisites section of the Setup program that are required for the product to 

work properly. All of the components listed in the Prerequisites section must be installed before installing the main product. Click 

on the first component in the Prerequisites section and read the descriptive information and installation requirements. Then, click 

the Install button for that component, located at the bottom of the screen. Do this for each component in the Prerequisites 

section. 

 

Click a section below for more information about that prerequsite component. Note: Not all products will have prerequisites.  

� Shared Assemblies Library  

� Microsoft AJAX Extensions 1.0  

� Bamboo AJAX Config  

Follow these guidelines to ensure a successful installation: 

1. Back up your system.  

2. Make sure that your system meets the requirements listed in the System Requirements section of the product's Online 

Documentation.  

3. Review KB.12464: Best Practices for Installing Bamboo Products before installing any product component.  

4. Review the Installation Location and Required Installation Permissions for each product component before installing it.  

5. Stop the World Wide Web Publishing Service before installation.  

TOP 

The Shared Assemblies Library is required when installing Bamboo products in a multiple Web front-end environment. Installing the 

Shared Assemblies Library will ensure that other Bamboo products are not affected if a Bamboo product is later upgraded or 

removed. For more information about the Shared Assemblies Library, read KB.12439: How to Install the Shared Assemblies Library. 

To install the Shared Assemblies Library, select the Shared Assemblies Library component from the Setup program. Click the 

Install button to start the Bamboo Core installer, which installs the Shared Assemblies Library. Repeat this installation on each 

Web front-end server in the SharePoint farm. 

Installing the Prerequisite Components

Recommendations for a Successful Installation

Shared Assemblies Library



 

Installation Location  

Install this component on all servers in the SharePoint farm running the Windows SharePoint Services Web Application service. 

Refer to Topology and Services in SharePoint Central Administration for a list of servers running this service.  

Required Installation Permissions  

The installation account must be a member of the local server Administrators group.  

TOP 

To install the Microsoft ASP.NET 2.0 AJAX Extensions 1.0, select the Microsoft AJAX Extensions 1.0 component from the Setup 

program. Click the Install button to start the Microsoft ASP.NET 2.0 AJAX Extensions 1.0 installer. Repeat this installation on 

each Web front-end server in the SharePoint farm. After installing this component, you must next install the Bamboo AJAX Config 

component to complete the AJAX installation. For more detailed information about the AJAX Extensions, visit the Microsoft ASP.NET 

AJAX 1.0 download page and read KB.12637: Configuring Microsoft AJAX Extensions for Bamboo Products. 

 

Microsoft AJAX Extensions 1.0



Installation Location  

Install this component on all servers in the SharePoint farm running the Windows SharePoint Services Web Application service. 

Refer to Topology and Services in SharePoint Central Administration for a list of servers running this service.  

Required Installation Permissions  

The installation account must be a member of the local server Administrators group. 

TOP 

To install the Bamboo AJAX Config, select the Bamboo AJAX Config component from the Setup program. Click the Install button 

to start the Bamboo AJAX Config installer, which completes the installation of the Microsoft ASP.NET AJAX Extensions. The 

Bamboo AJAX Config modifies the Web.config file for each selected Web application to enable support for the Microsoft ASP.NET 

AJAX Extensions. Read the Microsoft article Installing ASP.NET 2.0 AJAX Extensions 1.0 for details about the changes made by this 

component. For more information about the AJAX Extensions, including instructions for making required Web.config changes 

manually, read KB.12637: Configuring Microsoft AJAX Extensions for Bamboo Products. 

 

Installation Location  

Install this component on one of the servers in the SharePoint farm running the Windows SharePoint Services Web Application 

service. Refer to Topology and Services in SharePoint Central Administration for a list of servers running this service. This 

component will be automatically deployed to all selected Web applications by the SharePoint timer service.  

Required Installation Permissions  

The installation account must be a member of the local server Administrators group and the SharePoint Farm Administrators 

group.  

TOP 

Read all of the following information before installing the product: 

� Recommendations for a Successful Installation  

� Installation Location  

� Required Installation Permissions  

� Installation Instructions  

Follow these guidelines to ensure a successful installation: 

Bamboo AJAX Config

Installing the Product

Recommendations for a Successful Installation



1. Back up your system.  

2. Make sure that your system meets the requirements listed in the System Requirements section.  

3. Review KB.12464: Best Practices for Installing Bamboo Products before installing any product.  

4. Review the Installation Location and Required Installation Permissions for each product before installing it.  

5. Stop the World Wide Web Publishing Service before installation.  

TOP 

If you are installing a Bamboo product in a SharePoint farm environment, make sure to start the installation on the correct server. 

The required installation location is listed in the Setup program in the description for each component. 

Most Bamboo products must be installed on one Web front-end (WFE) server in the SharePoint farm where the Windows 

SharePoint Services Web Application service is running. Check Central Administration > Operations > Topology and 

Services for a list of servers running this service. The product will automatically be deployed to all other WFE servers in your farm. 

TOP 

Required installation permissions are listed in the Setup program in the description for each component. For most Bamboo products, 

the installation account must have the following permissions: 

� Member of the local server Administrators group  

� Member of the SharePoint Farm Administrators group  

� Site collection administrator (for automatic feature activation) 

TOP 

Stop! If you are upgrading from a previous version of the same product, make sure to check for important information in 

Upgrading from Previous Versions before installing. 

1. If the Setup program is not already running, double-click the Setup.bat file in the root of the product folder to launch it.  

2. Select the product component in the Setup program. Verify the installation location and required permissions and then click 

Install.  

3. Click Next to begin the installation. Verify that the system checks pass successfully, then read and accept the End-User License 

Agreement.  

4. In the Deployment Targets screen, select the Web application(s) where you want to install the product. Leave the 

Automatically activate features option checked to activate product features during installation. Click Next to begin 

installation.  

  

Note: If you prefer to activate product features manually after installation, uncheck the Automatically activate features 

option, then read Manually Activating the Product Features in the Online Documentation.  

  

5. When installation is complete, review the summary screen to confirm that the product installed successfully. Click Close.  

TOP 

Product feature activations can be done automatically at the site collection level when the product is installed. There are several 

reasons why you may need to manually activate (or deactivate) Bamboo product features: 

� You opted out of automatic feature activation during installation.  

� You add a new site collection and want to add Bamboo features to it.  

� You want to remove Bamboo product features from an existing site collection. 

To manually activate (or deactivate) Bamboo product features, follow the instructions below. 

Note: You must be a SharePoint site collection administrator to activate or deactivate features. Site collection administrators are 

assigned in SharePoint Central Administration. 

Installation Location

Required Installation Permissions

Installation Instructions

Manually Activating the Product Feature for a Site Collection



1. From the top-level site in the site collection, go to Site Actions > Site Settings > Site Collection Administration > Site 

Collection Features. 

 

2. Locate the Bamboo product feature. Click Activate to activate it for the entire site collection, or click Deactivate to deactivate 

it. 

 

Errors for this product are logged to %SystemDrive%\Windows\Temp\BambooSolutions\bsc_bamboo_%processid%.log on the 

server in the SharePoint farm running the Windows SharePoint Services Web Application service. Refer to Topology and 

Services in SharePoint Central Administration for a list of servers running this service.  

Locating the Error Log Files

Uninstalling the Product 



To uninstall: 

1. Double-click the Setup.bat program included in the product download ZIP file.  

2. From the Setup program screen, click the product component button under the Components section, and then click Install.  

3. The program performs the system checks. Once that has successfully completed, the program prompts you to Remove All, 

Upgrade/Repair Existing and Install New, or Install New Only. Select Remove All, and click Next.  

� Manual Product Installation  

� Manual Product Uninstallation 

WARNING: Bamboo recommends using the Setup program to install product components whenever possible. The Setup program is 

designed to ensure a successful product installation. Manual installation may lead to unexpected behavior during product 

configuration, licensing, or use, especially if your SharePoint environment contains issues normally detected and resolved when 

running the Setup program. 

The exact steps for manual installation will vary depending on the version of SharePoint the product is for, your SharePoint 

environment, and the individual product features. The information provided here includes general instructions for most product 

installation scenarios you may encounter. Read all sections carefully before manually installing a product. 

� About the Installation Files  

� Important Notes About Manual Installation  

� Manually Starting a Component Setup Application  

� Manually Installing and Deploying a Product Solution (WSP)  

� Manually Installing a Product MSI  

TOP 

When you extract the product EXE, several folders are created that contain installation files and Setup program configuration files. 

For manual installation, you will be accessing the following folders that contain installation files: 

� \[Component].wsp - There may be several folders ending in .wsp, depending on your product. Each WSP folder contains the 

installation files for a SharePoint solution.  

� \msi - The MSI folder may contain multiple files ending in .msi. Each .msi file is a single Windows installer package.  

TOP 

� Bamboo Web License Manager: If a product includes Bamboo Web License Manager (\Bamboo.Web.Licensing.wsp), add 

the solution to the solution store on the server running the Central Administration service, and deploy the solution to the 

Central Administration Web application.  

� Shared Assemblies Library (SharePoint 2007): If a product includes the Shared Assemblies Library 

(\msi\Bamboo.Core.V1.2.msi), you must install the MSI on all Web front-end servers in the farm.  

� Microsoft AJAX Extensions (SharePoint 2007): If a product includes the Microsoft AJAX Extensions 

(\msi\ASPAJAXExtSetup.msi), you must install the MSI on all Web front-end servers in the farm.  

� Bamboo AJAX Config (SharePoint 2007): If a product includes the Microsoft AJAX Extensions, the Bamboo AJAX Config 

(\Bamboo.AJAX.Config.wsp) solution must also be deployed. Deploy the solution to all Web applications in the farm where 

the product will be installed. You may also need to deploy this solution to the Central Administration Web application. Consult 

the Online Documentation for your product for more information.  

� \msi\*.x64.msi: Some MSI installers in the \msi installation folder have a 32-bit version and a 64-bit version. The 64-bit 

version will include .x64 in the file name. Run the version of the MSI that is appropriate for your operating system. Do not 

install both.  

� PackInstallation.wsp: Some products include an installation folder called PackInstallation.wsp. This folder is not needed 

during the manual installation process and can be ignored.  

TOP 

Manual Product Installation and Uninstallation

Manual Product Installation

About the Installation Files

Important Notes About Manual Installation



For your convenience, each component Setup application can be started directly from the Bamboo Setup program. The Bamboo 

Setup program can be started by double-clicking the file Setup.bat in the root of the extracted product folder.  

If you prefer to start an individual product component Setup from the product installation folder instead of from the Bamboo Setup 

program, navigate to its installation folder and double-click the \[Component].wsp\Setup.exe or \msi\[Component].msi file. 

The installation wizard for that component will start. Follow the installation instructions provided in the Online Documentation for 

your product.  

For example: To install and deploy just the Bamboo AJAX Config component from the product installation folders, navigate to the 

\Bamboo.AJAX.Config.wsp folder and double-click the file Setup.exe.  

If you start a component Setup application this way, you do not need to follow instructions for Manually Installing and Deploying a 

Product Solution. 

TOP 

Before installing, stop the World Wide Web Publishing Service (W3SVC). This will ensure that no system files that need to be 

updated are locked, which may cause the installation to fail. 

Your product may include several SharePoint solutions in multiple \[Component].wsp installation folders. Follow all steps in this 

section for each solution. 

The instructions in this section use the stsadm.exe command, which can be found in the following location: 

� SharePoint 2007: %PROGRAMFILES%\Common Files\Microsoft Shared\Web Server Extensions\12\BIN  

� SharePoint 2010: %PROGRAMFILES%\Common Files\Microsoft Shared\Web Server Extensions\14\BIN 

   

Step 1: Add the solution to the SharePoint solution store 

Perform this step on one server in your SharePoint farm running the SharePoint 2007 Windows SharePoint Services Web 

Application service or the SharePoint 2010 Microsoft SharePoint Foundation Web Application service. Use an account that is a 

member of the local server Administrators group.  

Note: For the Bamboo Web License Manager solution (\Bamboo.Web.Licensing.wsp), perform these steps on a server running 

the Central Administration service.  

� Run the following command to add each SharePoint solution to the solution store: 
  

stsadm.exe -o addsolution -filename [path]\[Component].wsp\cab\[Component].wsp 

  

[path] - the path to the extracted installation folders 

[Component] - the name of the component you are installing, as shown in the installation folder. The name of the component in 

the cab sub-folder may be different than the installation folder name. 

  

Step 2: Deploy the SharePoint solution 

After installing a SharePoint solution, it must be deployed to one or more Web applications. This section provides instructions for 

deploying from the command line or from SharePoint Central Administration. Pick the method that best fits your requirements. 

Option 1: Command-line Deployment 

Perform these steps on one server in your SharePoint farm running the SharePoint 2007 Windows SharePoint Services Web 

Application service or the SharePoint 2010 Microsoft SharePoint Foundation Web Application service. Use an account that is a 

member of the local server Administrators group. 

Note: For the Bamboo Web License Manager solution (Bamboo.UI.Licensing.wsp), perform these steps on a server running the 

Central Administration service. 

1. Schedule the solution for deployment to the SharePoint solution store using one of the options below.  

  

� Deploy a solution to a specific Web application (repeat for multiple Web applications): 
  

Manually Starting a Component Setup Application

Manually Installing and Deploying a Product Solution (WSP)



stsadm.exe -o deploysolution -name [Component].wsp -immediate -url 

[http://WebApplicationUri:portNumber]  

-allowGacDeployment -allowCasPolicies 

  

[Component] - the name of the component you installed, as shown in the cab installation sub-folder 

[http://WebApplicationUri:portNumber] - the URL and Port for the target Web application 

  

� Deploy a solution to all Web applications EXCEPT the Central Administration Web application: 
  

stsadm.exe -o deploysolution -name [Component].wsp -immediate -allcontenturls  

-allowGacDeployment -allowCasPolicies 

  

[Component] - the name of the component you installed, as shown in the cab installation sub-folder 

  

2. Execute the deployment job on each Web front-end server in the farm:   
  

stsadm.exe -o execadmsvcjobs 

   

Option 2: Deployment from SharePoint Central Administration 

Perform these steps using an account that is a member of the SharePoint Farm Administrators group. 

1. SharePoint 2007: In SharePoint Central Administration, click the Operations link. In the Global Configuration section, click the 

Solution Management link. 

SharePoint 2010: In SharePoint Central Administration, click the System Settings link. In the Farm Management section, click 

the Manage farm solutions link.  

2. Click on the name of the solution you just installed.  

3. Click the Deploy Solution link.  

4. Select the Web application to deploy to and a deployment schedule, and then click OK. 

   

Step 3: Manually Activate the Product Feature 

After the Bamboo product solution is deployed, it must be activated in each site collection before it can be used. 

Perform these steps using an account that is a SharePoint site collection administrator. 

1. From the top-level site in the site collection, go to Site Actions > Site Settings > Site Collection Administration > Site 

Collection Features.  

2. Locate the Bamboo product feature and click Activate to activate it for the entire site collection. Some products have more than 

one feature. Refer to the Online Documentation for your product for more information about manual feature activation.  

TOP 

Your product may include several components in the \msi installation folder, in addition to or instead of SharePoint solutions. 

Double-click on each MSI file to install it.  

MSI files must be installed on each server where the product is installed. Read the Important Notes About Manual Installation section 

for information about specific MSI files included with Bamboo products. 

Note: Some MSI installers in the \msi installation folder have a 32-bit and 64-bit version. The 64-bit version will include .x64 in the 

file name. Run the version of the MSI that is appropriate for your operating system. Do not install both. 

If you prefer to run the MSI installer from the command line, refer to the Microsoft TechNet article Msiexec (command-line options) 

for installation options. 

TOP 

Products may include a combination of SharePoint solutions (WSPs) and components installed using an MSI installer. Refer to the 

original installation files for information about the components that may have been installed. To manually uninstall a product 

component, read the following sections: 

Manually Installing a Product MSI

Manual Product Uninstallation



� Manually Uninstalling a SharePoint Solution  

� Manually Uninstalling a Product MSI  

� After Uninstalling a Product  

Your product may include several SharePoint solutions. Follow all steps in this section for each solution that you want to uninstall. 

For command-line uninstallation, you will need the name of the SharePoint solution that was deployed. This can be found in the cab 

installation sub-folder for a component. 

The instructions in this section use the stsadm.exe command, which can be found in the following location: 

� SharePoint 2007: %PROGRAMFILES%\Common Files\Microsoft Shared\Web Server Extensions\12\BIN  

� SharePoint 2010: %PROGRAMFILES%\Common Files\Microsoft Shared\Web Server Extensions\14\BIN  

To uninstall a SharePoint solution from the command line: 

1. Schedule the solution to be retracted from the Web application (Example 1) or from all Web applications EXCEPT Central 

Administration (Example 2): 
  

Example 1: stsadm.exe -o retractsolution -name [Component].wsp -immediate -url 

[http://WebApplicationUri:Port] 

Example 2: stsadm.exe -o retractsolution -name [Component].wsp -immediate -allcontenturls 

  

[Component] - the name of the installed component, as shown in the cab installation sub-folder 

[http://WebApplicationUri:portNumber] - the URL and Port for the Web application where the solution is installed 

  

2. Execute the retraction job on each Web front-end server in the farm: 
  

stsadm.exe -o execadmsvcjobs 

   

3. Delete the solution from the SharePoint solution store only AFTER the retraction job is complete: 

  
stsadm.exe -o deletesolution -name [Component].wsp 

  

[Component] - the name of the installed component, as shown in the cab installation sub-folder 

Additional Information: 

� The Bamboo AJAX Config and Bamboo Core solutions may be used by multiple Bamboo products. Do not uninstall them unless 

you are certain they are no longer in use.  

TOP 

If a product was installed using an MSI installer, it will be listed in the installed Programs and Features list in the Control Panel. To 

uninstall it, click on the name of the program and click Uninstall. 

If you prefer to uninstall the MSI from the command line, refer to the Microsoft TechNet article Msiexec (command-line options) for 

installation options. 

Additional Information: 

� The Bamboo Core and Microsoft AJAX Extensions may be used by multiple Bamboo products. Do not uninstall these unless you 

are certain they are no longer used.  

� Some product MSIs, like Bamboo Core and Microsoft AJAX Extensions, are installed on all Web front-end servers in the farm. To 

completely uninstall these components, you must uninstall them from each Web front-end server where they were installed.  

TOP 

Uninstalling a product will not remove product-related Web Parts from SharePoint site pages. To remove a Web Part from a page after 

a product is uninstalled: 

Manually Uninstalling a SharePoint Solution

Uninstalling a Product MSI

After Uninstalling a Product



1. On the page that contains the Web Part, go to Site Actions > Edit Page.  

2. Click the Edit menu for the Web Part and select Delete.  

3. Exit Edit Mode to save the page.  

TOP 

This section describes how to configure the Cross-Site Display Web Part.  

� Adding the Cross-Site Display Web Part to a Page  

� Configuring the Cross-Site Display Web Part  

� Localizing the Cross-Site Display Web Part  

After the product is installed, it is available in the Virtual Server Gallery. Users with the Designer or Full Control permission levels 

can add the Web Part to web site pages. 

To add the Web Part to a page: 

1. On a web site page, click Site Actions in the upper right corner.  

2. Select Edit Page.  

3. Find the zone where you want to install the Web Part and click Add a Web Part.  

4. From the Add Web Parts window, find and select the product check box, and then click Add. 

 

To display a SharePoint list or library in the Cross-Site Display Web Part, add the Bamboo Cross-Site Display Web Part to a page 

and modify the Web Part properties. Click the Cross-Site Display Web Part Settings button in the Web Part tool pane to display 

the Web Part Settings page.  

Note: You must disable pop-up blockers for the site to display the Web Part Settings. 

 

Cross-Site Display Web Part Configuration

Adding the Web Part to a Page

Configuring the Cross-Site Display Web Part



 

Click the links below for details about configuring Cross-Site Display Web Part settings. 

� General Settings  

� Language Settings  

� Online Resources and Customer Support  

 

Each instance of the Cross-Site Display Web Part can display one SharePoint list or library. The Cross-Site Display Web Part will 

automatically discover and display the view configured as the default view for that list or library. Read Supported Lists and Libraries 

for a list of the SharePoint lists, libraries, and views supported by the Cross-Site Display Web Part. 

To select a list or library to display in an instance of the Cross-Site Display Web Part: 

1. Click General Settings in the Preferences section of the Cross-Site Display Web Part Settings page.  

2. In the Enter a SharePoint site URL box, type the path to the SharePoint site that contains the list or library to display. Site 

URLs can be absolute (http://servername/site) or relative (./site). Bamboo recommends using a relative URL if the Web 

application has multiple access points using Alternative Access Mappings (AAM) or if the Web Part will be saved as part of a site 

template.  

3. Click the View Lists and Libraries button to populate the Available Lists and Libraries drop-down list.  

4. In the Select a list or library drop-down list, select the list or library to display in the Cross-Site Display Web Part. The Web 

Part will automatically discover the default view for the list or library.  

5. Click the Save & Close button to save the Web Part settings.  

6. In the Web Part tool pane, click Apply and then OK to view the list or library in the Web Part instance.  

General Settings
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To change the language used in the Web Part display and Web Part Settings page, perform the following steps: 

1. If your preferred language is something other than English, customize or create a language file using the instructions provided 

in Localizing the Cross-Site Display Web Part.  

2. Access the Cross-Site Display Web Part Settings and click Language Settings in the Preferences section.  

3. In the Select a Language drop-down list, select the desired language file.  

4. Click the Save & Close button to save the Web Part settings.  

5. In the Web Part tool pane, click Apply and then OK to view updates in the Web Part instance.  

Language Settings



 

TOP 

If you encounter difficulties or need assistance with the Cross-Site Display Web Part, read the information provided in the Help 

section of the Cross-Site Display Web Part Settings page.  

 

TOP 

Bamboo products can display user interface and tool pane text in your local language. To change the language a product displays, 

Online Resources and Customer Support

Localizing Bamboo Products



perform the steps described below. Click a link below for detailed information about each step. 

1. Customize a language file.  

2. Select the customized language file in the product configuration.  

There are four language files included with Bamboo products: 

� 1031.German.xml  

� 1033.English.xml  

� 1034.Spanish.xml  

� 1036.French.xml  

These files are located in the wpresources folder. This folder may be located under the following paths: 

� \\servername\drive\Inetpub\wwwroot\wss\VirtualDirectories\port\wpresources\[Product]  

� \\servername\drive\Program Files\Common Files\Microsoft Shared\web server extensions\wpresources\[Product] 

The German, Spanish and French files have not yet been translated; they are still in English. Edit these files directly to provide your 

own translation of the product user interface and tool pane text. To make sure that these files are not overwritten when you upgrade 

the product, copy the default file for the language you want to the wpresources folder and rename it, for example: 

CompanyName.1036.French.xml. If you do not rename the files you modify, these files will be overwritten when the product is 

upgraded. 

To create language files for languages other than German, English, Spanish, or French, copy one of the existing language files and 

rename it. Then edit the file to provide your own translation. 

The installation program will not remove or overwrite translation files you have created if they are named differently from the default 

resource files included with the product. However, product upgrades may require that you modify custom translation files to include 

new resource strings that were added for the new product version. The product will display the missing resource string IDs after an 

upgrade is completed. Copy these resource string IDs from a default language file to your custom translation file and make the 

appropriate changes for your language. 

The instructions below for changing language file settings apply to Bamboo products with settings configured in the Web Part tool 

pane or Web Part Settings pop-up page.  

Changing Language Settings in the Web Part Tool Pane 

1. Click the edit drop-down arrow on the Web Part title bar and select Modify Shared Web Part. 

 

2. In the Language settings section of the Web Part tool pane, select the language file you want to use. 

Customizing Language Files

Selecting a New Language File for a Product



 

3. Click Apply and then OK in the Web Part tool pane to apply your changes.  

  

Changing Language Settings in the Web Part Settings Pop-up Page 

1. From the Web Part, click the edit drop-down arrow on the Web Part title bar and select Modify Shared Web Part. 

 

2. Click the [Product] Settings button in the Web Part tool pane.

 

3. Click Language Settings in the Web Part Settings page and select the language file you want to use.

 

4. Click the Save & Close button to save the Web Part settings.  



5. Click Apply and then OK in the Web Part tool pane to apply your changes.  

Each instance of the Cross-Site Display Web Part can display one SharePoint list or library. The Cross-Site Display Web Part will 

automatically discover and display the view configured as the default view for that list or library. Read Supported Lists and Libraries 

for a list of the SharePoint lists, libraries, and views supported by the Cross-Site Display Web Part. 

Click the links below for details about using the Cross-Site Display Web Part. 

� Using the Web Part  

� Changing the List or Library View  

� Viewing, Editing, or Creating List or Library Items  

� Displaying Multiple Lists or Libraries on a Page  

� Cross-Site Display Web Part Security  

 

Each instance of the Cross-Site Display Web Part can display one SharePoint list or library. The Cross-Site Display Web Part will 

automatically discover and display the view configured as the default view for that list or library. Read Supported Lists and Libraries 

for a list of the SharePoint lists, libraries, and views supported by the Cross-Site Display Web Part. 

 

The Cross-Site Display Web Part will display the view as configured in the actual list or library, including any view options. The CSS 

of the view will match the master page of the site where the Cross-Site Display Web Part resides.  

 

The view toolbar will include access to new item actions, the Actions menu, the Settings menu, and the View drop-down list, if 

they are available to the currently logged-in user. 
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The Cross-Site Display Web Part will always display the view configured as the default view for the list or library, as shown below:  

Using the Cross-Site Display Web Part

Using the Web Part

Changing the List or Library View



 

To change the list view in the Cross-Site Display Web Part to something other than the default view, simply select an alternate view 

from the View drop-down menu. Note: View selections will reset the next time you visit the page. 
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You can view, edit, or create list or library items in the Cross-Site Display Web Part just as you can in the source list or library. The 

appropriate display, edit, or create form is displayed, and includes the same options provided when performing these actions in the 

source list or library. When you exit the view, edit, or create form, you will be returned to the page containing the Cross-Site Display 

Web Part. 

TOP 

To display multiple lists or libraries on a page, add multiple instances of the Cross-Site Display Web Part to a Web Part page. Each 

Web Part instance is configured individually and can display a different list or library. 

Viewing, Editing, or Creating List or Library Items

Displaying Multiple Lists or Libraries on a Page
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The Cross-Site Display Web Part honors SharePoint security trimming. If you do not have access to the source list or library, you will 

not be able to see that list or library in the Cross-Site Display Web Part. Instead, you will see the following message: 
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For trials, no license key is required. For more information on our licensing, refer to 

http://store.bamboosolutions.com/BambooMainWeb/FAQ.aspx. 

Once purchased, the product licensing is controlled through a separate license key and activation program installed on the server 

where SharePoint Central Administration is installed. To license Bamboo products, you must: 

1. Install the Bamboo Web License Manager on the SharePoint server where SharePoint Central Administration is installed (just 

install one time - not for each product that you install).  

2. From Bamboo Web License Manager, locate the product you want to activate, enter in your license key(s) and activate the 

product on the servers you want the product to run - all from one place. You can activate the license online or via email.  

You can also check the licensing status of Bamboo products you installed to determine whether a product trial will soon expire or 

whether the product has been deactivated or not. 

You must be a machine and SharePoint Farm administrator to install and run the Bamboo Web License Manager. 

1. On the server where SharePoint Central Administration is installed, then from the Setup program screen, click the Bamboo 

Web License Manager component button, then click Install.  

2. Click Next to continue.  

3. The program performs some system checks to determine whether your server is ready for installation. Click Next to continue.  

Cross-Site Display Web Part Security

About Licensing

Installing the Bamboo Web License Manager



4. The program is restricted to only install the Bamboo Web License Manager on the server where it detects the SharePoint Central 

Administration has been installed. This Web application should be already selected for you as well as the Automatically activate 

this feature check box. Click Next to continue.  

5. The Bamboo Web License Manager is then installed on the server. Click Next to view a details screen of the installation.   

6. Click Close. 

For troubleshooting and additional information, see the Knowledge Base or log into My Bamboo. 

TOP 

1. Open SharePoint Central Administration (make sure you have the proper access rights to log in), click Operations under the 

Central Administration section of the left navigation bar. 

 

2. Under the Bamboo Solutions Corporation section, click Bamboo Web License Manager. Note: If you have not yet installed 

any Bamboo products, the Web License Manager does not show any products. 

Licensing and Activating the Web Part



 

3. Expand the Individual Products or Suites section (depending on the product you want to license), locate your product, and 

click the product name to view the license status or click the drop-down arrow to Activate/Deactivate or view the Status. 

 

4. Do one of the following: 

� If you want to activate the product without viewing the status, click Activate/Deactivate from the drop-down (see 

screenshot above).  

� If you are viewing the licensing Status, then click the status to activate or deactivate the license. 

 

5. Do one of the following: 

� To activate online, type or copy and paste the license key into the field provided and click Activate. 



 

� To activate by email, enter the license key and select the Activate by E-mail check box, then click Activate. 

 

6. If you choose to activate by email, click the support@bamboosolutions.com email address and send the License Key and 

Machine Key to Bamboo Support. Our Support Team will reply with an activation key that you will then type into the boxes 

provided. Then click Activate.   

7. Your product has now been activated and is ready for use. 

 

8. Optional Step: Click the Choose License Server(s) link. This page allows you to select all the web front end servers you may 

want to install Bamboo products on. However, this is optional. Please read the license servers page to determine your 

selections. Click OK, after you have made your selections.  
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� Overview  

� Supported Lists and Libraries  

� System Requirements  

� Installation  

� Configuration  

� Using the Cross-Site Display Web Part  

� Licensing and Activation  

This section describes how to install, upgrade, uninstall, or activate the feature for the Cross-Site Display Web Part.  

� About the Setup Program  

� Installing the Cross-Site Display Web Part  

� Manually Activating the Product Features  

� Locating the Error Log Files  

� Uninstalling the Cross-Site Display Web Part  

� Manually Installing or Uninstalling the Cross-Site Display Web Part  

Before installing the product, read the Installing the Product section of the Online Documentation and review KB.12464: Best 

Practices for Installing Bamboo Products. 

To access the Setup program: 

1. Download the self-extracting product EXE from the storefront and save it to a local folder on the SharePoint server.  

2. Double-click the product EXE file to extract the contents of the product download.  

3. The Setup program will automatically start. To start the Setup program manually, double-click the Setup.bat file in the 

Cross-Site Display Web Part for SharePoint 2010 
Release 1.0 (HW63)

System Requirements

Operating System Windows Server 2003 or 2008 

Server SharePoint 2010: 

- Microsoft SharePoint Foundation 2010 or Microsoft SharePoint Server 2010 

Browser Microsoft Internet Explorer 8 or higher 

Cross-Site Display Web Part Installation

About the Setup Program



root of the folder where the product files were extracted.  

The Setup program may look different for different product versions. See examples below of the two Setup programs that are 

currently in use. Both versions of the Setup program work the same way. 

  

Note: The minimum screen resolution to view the Setup program is 1024x768. 

The Setup program contains links to each product component under the Components header on the left. Click on any of these links 

to view a description of the component on the right. The component description contains important information about where to 

install the component and the required permissions for the installation account. Read this information carefully before proceeding.  

Each product may have several components, which fall into the following categories: 

� Prerequisites: Some products include prequisite components that must be installed before the Bamboo product core 

components. Not all products will have prerequisites. Examples of prerequisites include the Shared Assemblies Library, Microsoft 

AJAX Extensions, and Bamboo AJAX Config.  

� Core Components: The product will include one or more core components that are required for the Bamboo product to work.  

� Optional Items: Optional items provide additional features or functionality but are not required to use the Bamboo product. 

Not all products will have optional items. Examples of optional items include the MashPoint Runtime Components and sample 

ASP.NET applications.  

� Licensing: All products will include the Bamboo Web License Manager or Bamboo License Manager. Licensing is required to 

activate a product license. It is not required during 30-day product trials.  

� Help: The Setup program also contains links to the Online Documentation and the Installation and Licensing Quick Start Guide. 

Links to other product-related resources, like the Bamboo Knowledge Base, may also be included.  

After reviewing the installation location and required installation permissions for a component, click the Install button at the bottom 

of the Setup screen to install it. If the product includes multiple components, click the Install button for each component. 

Click the Home icon  to return to the Setup main page. 

  

About the extracted product files: 

The extracted product files include the file Setup.bat, which launches the Setup program, and may also include the following 

folders:  

� \[Product].wsp: Contains the solution deployment file for this product. There may be more than one product WSP 

folder, depending on the product.  

� \docs: Contains the Installation and Licensing Quick Start Guide.  

� \msi : Contains installation executables for this product.  

� \res: Contains files required by the Setup program.  

� There may be other folders, depending on the requirements for the product.  

Read all of the following information before installing the product: 

Installing the Product



� Recommendations for a Successful Installation  

� Installation Location  

� Required Installation Permissions  

� Installation Instructions  

Follow these guidelines to ensure a successful installation: 

1. Back up your system.  

2. Make sure that your system meets the requirements listed in the System Requirements section.  

3. Review KB.12464: Best Practices for Installing Bamboo Products before installing any product.  

4. Review the Installation Location and Required Installation Permissions for each product before installing it.  

5. Stop the World Wide Web Publishing Service before installation.  

6. If you are upgrading the product from a SharePoint 2007 version to a SharePoint 2010 version, read KB.12630: Migrating 

Bamboo Products from SharePoint 2007 to SharePoint 2010.  

TOP 

If you are installing a Bamboo product in a SharePoint farm environment, make sure to start the installation on the correct server. 

The required installation location is listed in the Setup program in the description for each component. 

Most Bamboo products must be installed on one Web front-end (WFE) server in the SharePoint farm where the Microsoft 

SharePoint Foundation Web Application service is running. Check Central Administration > System Settings for a list of 

servers running this service. The product will automatically be deployed to all other WFE servers in your farm. 
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Required installation permissions are listed in the Setup program in the description for each component. For most Bamboo products, 

the installation account must have the following permissions: 

� Member of the local server Administrators group  

� Member of the SharePoint Farm Administrators group  

� Site collection administrator (for automatic feature activation) 

TOP 

1. If the Setup program is not already running, double-click the Setup.bat file in the root of the product folder to launch it.  

2. Select the product component in the Setup program. Verify the installation location and required permissions and then click 

Install.  

3. Click Next to begin the installation. Verify that the system checks pass successfully, then read and accept the End-User License 

Agreement.  

4. In the Deployment Targets screen, select the Web application(s) where you want to install the product. Leave the 

Automatically activate features option checked to activate product features during installation. Click Next to begin 

installation. 

 

Note: If you prefer to activate product features manually after installation, uncheck the Automatically activate features 

option, then read Manually Activating the Product Features in the Online Documentation.  

  

5. When installation is complete, review the summary screen to confirm that the product installed successfully. Click Close.  

TOP 

Product feature activations can be done automatically at the site collection level when the product is installed. There are several 

reasons why you may need to manually activate (or deactivate) Bamboo product features: 

Recommendations for a Successful Installation

Installation Location

Required Installation Permissions

Installation Instructions

Manually Activating the Product Feature for a Site Collection



� You opted out of automatic feature activation during installation.  

� You add a new site collection and want to add Bamboo features to it.  

� You want to remove Bamboo product features from an existing site collection. 

To manually activate (or deactivate) Bamboo product features, follow the instructions below. 

Note: You must be a SharePoint site collection administrator to activate or deactivate features. Site collection administrators are 

assigned in SharePoint Central Administration. 

1. From the top-level site in the site collection, go to Site Actions > Site Settings > Site Collection Administration > Site 

Collection Features. 

 

2. Locate the Bamboo product feature. Click Activate to activate it for the entire site collection, or click Deactivate to deactivate 

it. 

 

Errors for this product are logged to %SystemDrive%\Windows\Temp\BambooSolutions\bsc_bamboo_%processid%.log on the 

server in the SharePoint farm running the Microsoft SharePoint Foundation Web Application service. Refer to System 

Settings in SharePoint Central Administration for a list of servers running this service.  

Locating the Error Log Files

Uninstalling the Product



1. Delete the Web Part from all pages within each Web Application where the product is installed.  

2. Double-click the product EXE file.  

3. From the Setup program, click the product component button under the Components section, and then click Install.  

4. The program performs the system checks again. Once that has successfully completed, the program prompts you to 

Repair/Upgrade, Remove, Install New. Select Remove, and click Next. 

� Manual Product Installation  

� Manual Product Uninstallation 

WARNING: Bamboo recommends using the Setup program to install product components whenever possible. The Setup program is 

designed to ensure a successful product installation. Manual installation may lead to unexpected behavior during product 

configuration, licensing, or use, especially if your SharePoint environment contains issues normally detected and resolved when 

running the Setup program. 

The exact steps for manual installation will vary depending on the version of SharePoint the product is for, your SharePoint 

environment, and the individual product features. The information provided here includes general instructions for most product 

installation scenarios you may encounter. Read all sections carefully before manually installing a product. 

� About the Installation Files  

� Important Notes About Manual Installation  

� Manually Starting a Component Setup Application  

� Manually Installing and Deploying a Product Solution (WSP)  

� Manually Installing a Product MSI  

TOP 

When you extract the product EXE, several folders are created that contain installation files and Setup program configuration files. 

For manual installation, you will be accessing the following folders that contain installation files: 

� \[Component].wsp - There may be several folders ending in .wsp, depending on your product. Each WSP folder contains the 

installation files for a SharePoint solution.  

� \msi - The MSI folder may contain multiple files ending in .msi. Each .msi file is a single Windows installer package.  

TOP 

� Bamboo Web License Manager: If a product includes Bamboo Web License Manager (\Bamboo.Web.Licensing.wsp), add 

the solution to the solution store on the server running the Central Administration service, and deploy the solution to the 

Central Administration Web application.  

� Shared Assemblies Library (SharePoint 2007): If a product includes the Shared Assemblies Library 

(\msi\Bamboo.Core.V1.2.msi), you must install the MSI on all Web front-end servers in the farm.  

� Microsoft AJAX Extensions (SharePoint 2007): If a product includes the Microsoft AJAX Extensions 

(\msi\ASPAJAXExtSetup.msi), you must install the MSI on all Web front-end servers in the farm.  

� Bamboo AJAX Config (SharePoint 2007): If a product includes the Microsoft AJAX Extensions, the Bamboo AJAX Config 

(\Bamboo.AJAX.Config.wsp) solution must also be deployed. Deploy the solution to all Web applications in the farm where 

the product will be installed. You may also need to deploy this solution to the Central Administration Web application. Consult 

the Online Documentation for your product for more information.  

� \msi\*.x64.msi: Some MSI installers in the \msi installation folder have a 32-bit version and a 64-bit version. The 64-bit 

version will include .x64 in the file name. Run the version of the MSI that is appropriate for your operating system. Do not 

install both.  

� PackInstallation.wsp: Some products include an installation folder called PackInstallation.wsp. This folder is not needed 

during the manual installation process and can be ignored.  

TOP 

Manual Product Installation and Uninstallation

Manual Product Installation

About the Installation Files

Important Notes About Manual Installation

Manually Starting a Component Setup Application



For your convenience, each component Setup application can be started directly from the Bamboo Setup program. The Bamboo 

Setup program can be started by double-clicking the file Setup.bat in the root of the extracted product folder.  

If you prefer to start an individual product component Setup from the product installation folder instead of from the Bamboo Setup 

program, navigate to its installation folder and double-click the \[Component].wsp\Setup.exe or \msi\[Component].msi file. 

The installation wizard for that component will start. Follow the installation instructions provided in the Online Documentation for 

your product.  

For example: To install and deploy just the Bamboo AJAX Config component from the product installation folders, navigate to the 

\Bamboo.AJAX.Config.wsp folder and double-click the file Setup.exe.  

If you start a component Setup application this way, you do not need to follow instructions for Manually Installing and Deploying a 

Product Solution. 
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Before installing, stop the World Wide Web Publishing Service (W3SVC). This will ensure that no system files that need to be 

updated are locked, which may cause the installation to fail. 

Your product may include several SharePoint solutions in multiple \[Component].wsp installation folders. Follow all steps in this 

section for each solution. 

The instructions in this section use the stsadm.exe command, which can be found in the following location: 

� SharePoint 2007: %PROGRAMFILES%\Common Files\Microsoft Shared\Web Server Extensions\12\BIN  

� SharePoint 2010: %PROGRAMFILES%\Common Files\Microsoft Shared\Web Server Extensions\14\BIN 

   

Step 1: Add the solution to the SharePoint solution store 

Perform this step on one server in your SharePoint farm running the SharePoint 2007 Windows SharePoint Services Web 

Application service or the SharePoint 2010 Microsoft SharePoint Foundation Web Application service. Use an account that is a 

member of the local server Administrators group.  

Note: For the Bamboo Web License Manager solution (\Bamboo.Web.Licensing.wsp), perform these steps on a server running 

the Central Administration service.  

� Run the following command to add each SharePoint solution to the solution store: 
  

stsadm.exe -o addsolution -filename [path]\[Component].wsp\cab\[Component].wsp 

  

[path] - the path to the extracted installation folders 

[Component] - the name of the component you are installing, as shown in the installation folder. The name of the component in 

the cab sub-folder may be different than the installation folder name. 

  

Step 2: Deploy the SharePoint solution 

After installing a SharePoint solution, it must be deployed to one or more Web applications. This section provides instructions for 

deploying from the command line or from SharePoint Central Administration. Pick the method that best fits your requirements. 

Option 1: Command-line Deployment 

Perform these steps on one server in your SharePoint farm running the SharePoint 2007 Windows SharePoint Services Web 

Application service or the SharePoint 2010 Microsoft SharePoint Foundation Web Application service. Use an account that is a 

member of the local server Administrators group. 

Note: For the Bamboo Web License Manager solution (Bamboo.UI.Licensing.wsp), perform these steps on a server running the 

Central Administration service. 

1. Schedule the solution for deployment to the SharePoint solution store using one of the options below.  

  

� Deploy a solution to a specific Web application (repeat for multiple Web applications): 
  

stsadm.exe -o deploysolution -name [Component].wsp -immediate -url 

Manually Installing and Deploying a Product Solution (WSP)



[http://WebApplicationUri:portNumber]  

-allowGacDeployment -allowCasPolicies 

  

[Component] - the name of the component you installed, as shown in the cab installation sub-folder 

[http://WebApplicationUri:portNumber] - the URL and Port for the target Web application 

  

� Deploy a solution to all Web applications EXCEPT the Central Administration Web application: 
  

stsadm.exe -o deploysolution -name [Component].wsp -immediate -allcontenturls  

-allowGacDeployment -allowCasPolicies 

  

[Component] - the name of the component you installed, as shown in the cab installation sub-folder 

  

2. Execute the deployment job on each Web front-end server in the farm:   
  

stsadm.exe -o execadmsvcjobs 

   

Option 2: Deployment from SharePoint Central Administration 

Perform these steps using an account that is a member of the SharePoint Farm Administrators group. 

1. SharePoint 2007: In SharePoint Central Administration, click the Operations link. In the Global Configuration section, click the 

Solution Management link. 

SharePoint 2010: In SharePoint Central Administration, click the System Settings link. In the Farm Management section, click 

the Manage farm solutions link.  

2. Click on the name of the solution you just installed.  

3. Click the Deploy Solution link.  

4. Select the Web application to deploy to and a deployment schedule, and then click OK. 

   

Step 3: Manually Activate the Product Feature 

After the Bamboo product solution is deployed, it must be activated in each site collection before it can be used. 

Perform these steps using an account that is a SharePoint site collection administrator. 

1. From the top-level site in the site collection, go to Site Actions > Site Settings > Site Collection Administration > Site 

Collection Features.  

2. Locate the Bamboo product feature and click Activate to activate it for the entire site collection. Some products have more than 

one feature. Refer to the Online Documentation for your product for more information about manual feature activation.  
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Your product may include several components in the \msi installation folder, in addition to or instead of SharePoint solutions. 

Double-click on each MSI file to install it.  

MSI files must be installed on each server where the product is installed. Read the Important Notes About Manual Installation section 

for information about specific MSI files included with Bamboo products. 

Note: Some MSI installers in the \msi installation folder have a 32-bit and 64-bit version. The 64-bit version will include .x64 in the 

file name. Run the version of the MSI that is appropriate for your operating system. Do not install both. 

If you prefer to run the MSI installer from the command line, refer to the Microsoft TechNet article Msiexec (command-line options) 

for installation options. 
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Products may include a combination of SharePoint solutions (WSPs) and components installed using an MSI installer. Refer to the 

original installation files for information about the components that may have been installed. To manually uninstall a product 

component, read the following sections: 

� Manually Uninstalling a SharePoint Solution  

Manually Installing a Product MSI

Manual Product Uninstallation



� Manually Uninstalling a Product MSI  

� After Uninstalling a Product  

Your product may include several SharePoint solutions. Follow all steps in this section for each solution that you want to uninstall. 

For command-line uninstallation, you will need the name of the SharePoint solution that was deployed. This can be found in the cab 

installation sub-folder for a component. 

The instructions in this section use the stsadm.exe command, which can be found in the following location: 

� SharePoint 2007: %PROGRAMFILES%\Common Files\Microsoft Shared\Web Server Extensions\12\BIN  

� SharePoint 2010: %PROGRAMFILES%\Common Files\Microsoft Shared\Web Server Extensions\14\BIN  

To uninstall a SharePoint solution from the command line: 

1. Schedule the solution to be retracted from the Web application (Example 1) or from all Web applications EXCEPT Central 

Administration (Example 2): 
  

Example 1: stsadm.exe -o retractsolution -name [Component].wsp -immediate -url 

[http://WebApplicationUri:Port] 

Example 2: stsadm.exe -o retractsolution -name [Component].wsp -immediate -allcontenturls 

  

[Component] - the name of the installed component, as shown in the cab installation sub-folder 

[http://WebApplicationUri:portNumber] - the URL and Port for the Web application where the solution is installed 

  

2. Execute the retraction job on each Web front-end server in the farm: 
  

stsadm.exe -o execadmsvcjobs 

   

3. Delete the solution from the SharePoint solution store only AFTER the retraction job is complete: 

  
stsadm.exe -o deletesolution -name [Component].wsp 

  

[Component] - the name of the installed component, as shown in the cab installation sub-folder 

Additional Information: 

� The Bamboo AJAX Config and Bamboo Core solutions may be used by multiple Bamboo products. Do not uninstall them unless 

you are certain they are no longer in use.  

TOP 

If a product was installed using an MSI installer, it will be listed in the installed Programs and Features list in the Control Panel. To 

uninstall it, click on the name of the program and click Uninstall. 

If you prefer to uninstall the MSI from the command line, refer to the Microsoft TechNet article Msiexec (command-line options) for 

installation options. 

Additional Information: 

� The Bamboo Core and Microsoft AJAX Extensions may be used by multiple Bamboo products. Do not uninstall these unless you 

are certain they are no longer used.  

� Some product MSIs, like Bamboo Core and Microsoft AJAX Extensions, are installed on all Web front-end servers in the farm. To 

completely uninstall these components, you must uninstall them from each Web front-end server where they were installed.  
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Uninstalling a product will not remove product-related Web Parts from SharePoint site pages. To remove a Web Part from a page after 

a product is uninstalled: 

Manually Uninstalling a SharePoint Solution

Uninstalling a Product MSI

After Uninstalling a Product



1. On the page that contains the Web Part, go to Site Actions > Edit Page.  

2. Click the Edit menu for the Web Part and select Delete.  

3. Exit Edit Mode to save the page.  
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This section describes how to configure the Cross-Site Display Web Part.  

� Adding the Cross-Site Display Web Part to a Page  

� Configuring the Cross-Site Display Web Part  

� Localizing the Cross-Site Display Web Part  

After the product is installed, it is available in the Virtual Server Gallery. Users with the Designer or Full Control permission levels 

can add the Web Part to web site pages. 

To add the Web Part to a page: 

1. From a web site page, click Site Actions in the upper left corner, then select Edit Page. 

 

2. Click Add a Web Part in the area on the page where you want to add the Web Part. 

Cross-Site Display Web Part Configuration

Adding the Web Part to a Page in SharePoint 2010



 

3. Select a category, select a Web Part (use the arrows at the bottom of the Web Part area to scroll through all Web Parts available 

in the selected category), read about the Web Part and choose to add it to a different area of the page if needed, then click 

Add. 

 

4. Click the Stop Editing button in the ribbon to stop editing the page. Then select the Browse tab at the top left of the page to 

see the page as other users will view it. 

  

Configuring the Cross-Site Display Web Part



To display a SharePoint list or library in the Cross-Site Display Web Part, add the Bamboo Cross-Site Display Web Part to a page 

and modify the Web Part properties. Click the Cross-Site Display Web Part Settings button in the Web Part tool pane to display 

the Web Part Settings page.  

Note: You must disable pop-up blockers for the site to display the Web Part Settings. 

 

 

Click the links below for details about configuring Cross-Site Display Web Part settings. 

� General Settings  

� Language Settings  

� Online Resources and Customer Support  

 

Each instance of the Cross-Site Display Web Part can display one SharePoint list or library. The Cross-Site Display Web Part will 

automatically discover and display the view configured as the default view for that list or library. Read Supported Lists and Libraries 

for a list of the SharePoint lists, libraries, and views supported by the Cross-Site Display Web Part. 

To select a list or library to display in an instance of the Cross-Site Display Web Part: 

1. Click General Settings in the Preferences section of the Cross-Site Display Web Part Settings page.  

2. In the Enter a SharePoint site URL box, type the path to the SharePoint site that contains the list or library to display. Site 

URLs can be absolute (http://servername/site) or relative (./site). Bamboo recommends using a relative URL if the Web 

application has multiple access points using Alternative Access Mappings (AAM) or if the Web Part will be saved as part of a site 

template.  

3. Click the View Lists and Libraries button to populate the Available Lists and Libraries drop-down list.  

4. In the Select a list or library drop-down list, select the list or library to display in the Cross-Site Display Web Part. The Web 

Part will automatically discover the default view for the list or library.  

5. Click the Save & Close button to save the Web Part settings.  

6. In the Web Part tool pane, click Apply and then OK to view the list or library in the Web Part instance.  

General Settings
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To change the language used in the Web Part display and Web Part Settings page, perform the following steps: 

1. If your preferred language is something other than English, customize or create a language file using the instructions provided 

in Localizing the Cross-Site Display Web Part.  

2. Access the Cross-Site Display Web Part Settings and click Language Settings in the Preferences section.  

3. In the Select a Language drop-down list, select the desired language file.  

4. Click the Save & Close button to save the Web Part settings.  

5. In the Web Part tool pane, click Apply and then OK to view updates in the Web Part instance.  

Language Settings
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If you encounter difficulties or need assistance with the Cross-Site Display Web Part, read the information provided in the Help 

section of the Cross-Site Display Web Part Settings page.  

 

TOP 

Bamboo products can display user interface and tool pane text in your local language. To change the language a product displays, 

Online Resources and Customer Support

Localizing Bamboo Products



perform the steps described below. Click a link below for detailed information about each step. 

1. Customize a language file.  

2. Select the customized language file in the product configuration.  

There are four language files included with Bamboo products: 

� 1031.German.xml  

� 1033.English.xml  

� 1034.Spanish.xml  

� 1036.French.xml  

These files are located in the wpresources folder. This folder may be located under the following paths: 

� \\servername\drive\Inetpub\wwwroot\wss\VirtualDirectories\port\wpresources\[Product]  

� \\servername\drive\Program Files\Common Files\Microsoft Shared\web server extensions\wpresources\[Product] 

The German, Spanish and French files have not yet been translated; they are still in English. Edit these files directly to provide your 

own translation of the product user interface and tool pane text. To make sure that these files are not overwritten when you upgrade 

the product, copy the default file for the language you want to the wpresources folder and rename it, for example: 

CompanyName.1036.French.xml. If you do not rename the files you modify, these files will be overwritten when the product is 

upgraded. 

To create language files for languages other than German, English, Spanish, or French, copy one of the existing language files and 

rename it. Then edit the file to provide your own translation. 

The installation program will not remove or overwrite translation files you have created if they are named differently from the default 

resource files included with the product. However, product upgrades may require that you modify custom translation files to include 

new resource strings that were added for the new product version. The product will display the missing resource string IDs after an 

upgrade is completed. Copy these resource string IDs from a default language file to your custom translation file and make the 

appropriate changes for your language. 

The instructions below for changing language file settings apply to Bamboo products with settings configured in the Web Part tool 

pane or Web Part Settings pop-up page.  

Changing Language Settings in the Web Part Tool Pane 

1. Click the edit drop-down arrow on the Web Part title bar and select Edit Web Part. 

 

2. In the Language settings section of the Web Part tool pane, select the language file you want to use. 

 

3. Click Apply and then OK in the Web Part tool pane to apply your changes.  

Customizing Language Files

Selecting a New Language File for a Product



  

Changing Language Settings in the Web Part Settings Pop-up Page 

1. From the Web Part, click the edit drop-down arrow on the Web Part title bar and select Modify Shared Web Part. 

 

2. Click the [Product] Settings button in the Web Part tool pane.

 

3. Click Language Settings in the Web Part Settings page and select the language file you want to use.

 

4. Click the Save & Close button to save the Web Part settings.  

5. Click Apply and then OK in the Web Part tool pane to apply your changes.  

Each instance of the Cross-Site Display Web Part can display one SharePoint list or library. The Cross-Site Display Web Part will 

automatically discover and display the view configured as the default view for that list or library. Read Supported Lists and Libraries 

for a list of the SharePoint lists, libraries, and views supported by the Cross-Site Display Web Part. 

Click the links below for details about using the Cross-Site Display Web Part. 

� Using the Web Part  

� Changing the List or Library View  

� Viewing, Editing, or Creating List or Library Items  

� Displaying Multiple Lists or Libraries on a Page  

� Cross-Site Display Web Part Security  

Using the Cross-Site Display Web Part



 

Each instance of the Cross-Site Display Web Part can display one SharePoint list or library. The Cross-Site Display Web Part will 

automatically discover and display the view configured as the default view for that list or library. Read Supported Lists and Libraries 

for a list of the SharePoint lists, libraries, and views supported by the Cross-Site Display Web Part. 

 

The Cross-Site Display Web Part will display the view as configured in the actual list or library, including any view options. The CSS 

of the view will match the master page of the site where the Cross-Site Display Web Part resides.  

 

The view toolbar will include access to new item actions, the Actions menu, the Settings menu, and the View drop-down list, if 

they are available to the currently logged-in user. 
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The Cross-Site Display Web Part will always display the view configured as the default view for the list or library, as shown below:  

Using the Web Part

Changing the List or Library View



 

To change the list view in the Cross-Site Display Web Part to something other than the default view, simply select an alternate view 

from the View drop-down menu. Note: View selections will reset the next time you visit the page. 
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You can view, edit, or create list or library items in the Cross-Site Display Web Part just as you can in the source list or library. The 

appropriate display, edit, or create form is displayed, and includes the same options provided when performing these actions in the 

source list or library. When you exit the view, edit, or create form, you will be returned to the page containing the Cross-Site Display 

Web Part. 
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To display multiple lists or libraries on a page, add multiple instances of the Cross-Site Display Web Part to a Web Part page. Each 

Web Part instance is configured individually and can display a different list or library. 

Viewing, Editing, or Creating List or Library Items

Displaying Multiple Lists or Libraries on a Page
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The Cross-Site Display Web Part honors SharePoint security trimming. If you do not have access to the source list or library, you will 

not be able to see that list or library in the Cross-Site Display Web Part. Instead, you will see the following message: 
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For trials, no license key is required. For more information on our licensing, refer to 

http://store.bamboosolutions.com/BambooMainWeb/FAQ.aspx. 

Once purchased, the product licensing is controlled through a separate license key and activation program installed on the server 

where SharePoint Central Administration is installed. To license Bamboo products, you must: 

1. Install the Bamboo Web License Manager on the SharePoint server where SharePoint Central Administration is installed (just 

install one time - not for each product that you install).  

2. From Bamboo Web License Manager, locate the product you want to activate, enter in your license key(s) and activate the 

product on the servers where you want the product to run - all from one place. You can activate the license online or via email.  

You can also check the licensing status of Bamboo products you installed to determine whether a product trial will soon expire or 

whether the product has been deactivated or not. 

You must be a machine and SharePoint Farm administrator to install and run the Bamboo Web License Manager. 

1. On the server where SharePoint Central Administration is installed, then from the Setup program screen, click the Bamboo 

Web License Manager component button, then click Install.  

2. Read the End-User License Agreement and choose to accept or abort the install.  

Cross-Site Display Web Part Security

About Licensing

Installing the Bamboo Web License Manager



3. Click Next to continue.  

4. The program performs some system checks to determine whether your server is ready for installation. Click Next to continue.  

5. The program is restricted to only install the Bamboo Web License Manager on the server where it detects the SharePoint Central 

Administration has been installed. This web application should already be selected for you as well as the Automatically activate 

features check box. Click Next to continue.  

6. The Bamboo Web License Manager is then installed on the server. Click Next to view a details screen of the installation.   

7. Click Close. 

Note: If you encounter any issues with the installation, please reference our Knowledge Base for help and troubleshooting. 

1. Open SharePoint Central Administration (make sure you have the proper access rights to log in). Notice the Bamboo Solutions 

heading at the bottom of the page.  

 

2. Under the Bamboo Solutions section, click Manage My License Keys.  

Note: If you have not yet installed any Bamboo products, the Web License Manager will not show any products. If you have 

installed Bamboo products that support the new Web Licensing Manager prior to installing the Bamboo Web License Manager, 

you will need to uninstall those Bamboo products and reinstall them in order to manage them in the Bamboo Web License 

Manager. This is optional. Your licensed Bamboo products will continue to run regardless of whether they show in the Web 

License Manager. 

3. Expand the Individual Products section or the Suites section (depending on the product/suite you want to license), locate 

your product, and click the product name to view the license status or click the drop-down arrow to Activate/Deactivate or 

view the Status. 

Licensing and Activating the Web Part



 

4. Do one of the following: 

� If you want to activate the product without viewing the status, click Activate/Deactivate from the drop-down (see 

screenshot above).  

� If you choose to view the licensing Status, then click the status to activate or deactivate the license. 

 

5. Do one of the following: 

� To activate online, type or copy and paste the license key into the field provided and click Activate. 



 

� To activate by email, enter the license key and select the Activate by E-mail check box, then click Activate. 

  

6. If you choose to activate by email, click the support@bamboosolutions.com email address and send the License Key and 

Machine Key to Bamboo Support. Our Support Team will reply with an activation key that you will then type into the boxes 

provided. Then click Activate.   

7. Your product has now been activated and is ready for use. 



 

8. Optional Step: Click the Choose License Server(s) link. This page allows you to select all the web front end servers you may 

want to install Bamboo products on. However, this is optional. Please read the license servers page to determine your 

selections. Click OK, after you have made your selections.  

 


